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 Make the most of your Business Internet High Speed service!   1

 

Below are all the steps you will go through to get connected with the Business Internet High Speed service. 
Remember to take advantage of all of the additional features that the service offers!

MAKE THE MOST OF YOUR BUSINESS INTERNET HIGH SPEED SERVICE!

Order our
service!

Receive a
Welcome

Letter in the
mail

SURF THE
INTERNET at
HIGH SPEED!

Receive your
k it in the Mail

Install the
ha rdware

Install the
software

Connecting and
Disconnecting from

the Internet

Make use of our
ADDITIONAL
FEATURES!

Use the Global
Roaming Dialer to

connect to the
Internet when you

are away from work!

View your e-mail
online, and subscribe

to our NEW email
enhancements!

Create a new e-mail account

View  your bill ing details online

Order another High Speed account...

Change passwords

Visit eCare!
http://en.bellnet.ca

Service technician will come install your service

page 3 page 8 page 12

page 18 page 26

page 28

 

Please keep note that your Business Internet High Speed service will be activated by midnight 
on the due date given to you at the time of purchase.



 

2   Make the most of your Business Internet High Speed service!

 

For the Business Internet High Speed software to work reliably and efficiently, your computer must meet or 
exceed the minimum requirements specified in the table below:

 

Check the contents of your Starter Kit

 

To see a list of the equipment you should have, consult 

 

Check the contents of your Starter Kit

 

 on page 3.

 

Install the hardware

 

1.

 

Connect the modem and install the phone filters on every phone with the same telephone number as 
your Business Internet High Speed service. Do not install filters on your modem.

 

2.

 

Check your setup. Please refer to 

 

Checking your setup

 

 on page 6 for an illustration of the proper hardware 
setup.

 

Install the software

 

3.

 

Turn on your computer. Exit all programs and disable any virus protection software.

 

4.

 

Insert the Business Internet CD into your CD ROM drive.

 

5.

 

Follow the instructions to install the software.

 

Connecting and Disconnecting from the Internet

 

6.

 

Double-click the 

 

Business Internet High Speed

 

 icon in the 

 

Internet High Speed

 

 folder. The Business 
Internet High Speed software starts. Click 

 

Connect

 

 to connect to the Business Internet High Speed 
service.

 

7.

 

To disconnect, click the 

 

File

 

 menu in Internet Explorer, then click 

 

Quit

 

. To disconnect from the Internet, 
double-click the 

 

Business Internet High Speed

 

 icon in the 

 

Internet High Speed

 

 folder, then click 

 

Disconnect

 

.

 

Macintosh
Processor

 

Power PC

 

System

 

Mac OS 8.6 - 9.2

 

Memory

 

32 MB RAM

 

Hard drive

 

75 MB free

 

Display

 

256 colours with 800x600 resolution

 

Network card

 

Ethernet card

 

CD-ROM drive

 

Required

M I N I M U M  H A R D W A R E  R E Q U I R E M E N T S

Q U I C K  S T A R T  P R O C E D U R E S



 

Installing the Hardware  3

 

Your Business Internet High Speed Starter kit should contain the following:

 

1.

 

DSL high speed modem box, if you ordered one from Bell, should contain:

 

a.

 

DSL high speed modem (your modem may look different, depending on the brand)

 

• Note:

 

 BC and Alberta customers’ modems will be shipped separately from their Internet High Speed 
Starter kit.

 

b.

 

DC power supply with cable

 

c.

 

Telephone cable with standard telephone plugs, called RJ-11

 

d.

 

Ethernet cable with plugs slightly larger than the phone cable plugs, called RJ-45

 

e.

 

USB cable only included with the Speedstream 5200 modem (for Windows only)

 

2.

 

Desktop filters. 

 

(Additional filters (including wall filters) can be ordered online at 

 

www.proformagms.com/bell

 

)

 

3.

 

1 Telephone line splitter

 

4.

 

Installation Guide (what you are currently reading)

 

5.

 

Software Installation CD

I N S T A L L I N G  T H E  H A R D W A R E

C H E C K  T H E  C O N T E N T S  O F  Y O U R  S T A R T E R  K I T

1a 1b

1c

4

1c 5

2

1e

1d

3



 

4  Installing the Hardware

 

Leave your computer on while you perform the following steps.

 

You must now install a filter on every phone with the same telephone number as your Business 
Internet High Speed service.
If you require additional filters or wall filters for wall mounted phones, you can order them 
online at 

 

http://www.proformagms.com/bell

 

Repeat this process for 

 

every desktop phone

 

 on the same line as your Business Internet High Speed 
service:

 

1.

 

Unplug the telephone cable from the wall jack, and plug a 
desktop filter into the wall jack.

 

2.

 

Plug the telephone cable you unplugged from the wall jack 
into the filter.

 

1.

 

First plug the phone cable from the modem into the splitter.

 

2.

 

Then plug the filter (from the phone) into the splitter.

C O N N E C T I N G  A  F I L T E R  T O  E V E R Y  P H O N E

I F  A  W A L L  J A C K  I S  T O  B E  S H A R E D  B Y  M O D E M  A N D  P H O N E  ( O P T I O N A L )

From modem

From phone



Installing the Hardware  5

1. Make sure that the Efficient Networks SpeedStream 5200 
modem has adequate ventilation. Place the modem on an 
even, hard surface at least one foot away from your moni-
tor, computer case, or other electronic devices including 
speakers. The modem will need to be within 6 feet (or 2 
meters) of your phone jack.
Your modem should be supplied with an Ethernet cable, 
and a phone cable. The Ethernet cable has slightly larger 
plugs.

2. Connect one of end of the Ethernet cable to the Ethernet 
card installed in your desktop computer, or to the media 
coupler attached to your laptop computer.

3. Connect the other end of the Ethernet cable into the largest jack on 
the back of your modem.

Depending on your modem brand, the jack will be labeled 

Ethernet, 10Base T, ENET, or this symbol .

4. Connect one end of the phone cable to your telephone wall jack.

5. Connect the other end of the phone cable to the back of your 
modem.

Depending on your modem brand, the jack will be labeled ADSL, 

DSL, Line, or this symbol .

6. Connect your modem’s power supply to the modem, and then plug the other end into a power bar. A 
surge protected power bar is recommended.

Proceed to Checking your setup on page 6.

C O N N E C T I N G  T H E  M O D E M

Ethernet cablePhone cable

DesktopLaptop



6  Installing the Hardware

If you have the Alcatel modem, the overall wiring should look like this:

If you have the SpeedStream modem, the setup should look like this:

C H E C K I N G  Y O U R  S E T U P

RJ45 ETHERNET CABLE

RJ11 PHONE CABLE
FILTER

PHONE JACKSPLITTER

RJ11 PHONE CABLE

DC POWER SUPPLY

RJ11 PHONE CABLE

PHONE JACK
RJ11 PHONE CABLE

FILTER SPLITTER

DC POWER SUPPLY

RJ45 ETHERNET CABLE
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All other rooms 
with phones that 
have the same 
number as your 
internet service:

1. Make sure your modem and computer are turned on.

If the lights are not on, turn the modem and computer off. Make sure that all the cables are connected 
securely, then turn the computer and modem back on. If this does not work, contact the Help Desk. The 
appropriate number is on the first page of this guide.

Proceed to Configuring the Software on page 8.

2. If you have the SpeedStream modem, wait until the 
pwr, dsl, and enet lights are on.

If you have an Alcatel modem, wait until there are two 
solid green lights on the modem.

RJ11 PHONE CABLE
FILTER PHONE JACK

C H E C K I N G  Y O U R  S E T U P  ( C O N T I N U E D )



8   Configuring the Software

At this point you should have completed Installing the Hardware and your DSL High Speed 
modem should be connected to your phone line and turned on, your telephone filters should 
also be installed.

For the Business Internet High Speed software to work reliably and efficiently, your computer 
must meet or exceed the minimum hardware requirements specified on page 2.

Before you begin, have the following information ready in order to install the software:

• your Business Internet High Speed 

• User ID

• password

• email address

• outgoing mail (SMTP) server

• incoming mail (POP) server

• news (NNTP) server

The Business Internet High Speed software is not designed to support Internet access over a 
Local Area Network (LAN). Configuring the Business Internet High Speed software may cause 
conflicts with your existing network service.

If you have Mac OS X, please turn to Connecting to the Business Internet High Speed with Mac OS X on 
page 13.

1. Exit any applications or programs, and disable any virus protection software before installing the soft-
ware. For instructions, see the manual that came with your virus protection software.

2. Insert the Business Internet Dial CD into your CD-ROM drive. Double-click the English folder in the CD-
ROM window that appears. Drag the Microsoft Internet 5 folder to your hard drive.

C O N F I G U R I N G  T H E  S O F T W A R E

B E F O R E  Y O U  B E G I N

I N S T A L L I N G  T H E  S O F T W A R E



 Configuring the Software   9

1. In the CD-ROM window, double-click English folder, then the High Speed folder, then the Internet 
High Speed128 icon.

2. The Business Internet High Speed installation screen appears. Follow the instructions to install the 
software.

3. The screen displays the Business Internet High 
Speed setup window. Enter your Business Internet 
High Speed User ID, followed by the @ symbol and 
your domain name, and your Business Internet 
High Speed password in lower case letters in the 
appropriate boxes.

4. A progress bar displays the Business Internet High 
Speed software being copied to your hard drive.

5. You will see a screen indicating that the installation is finished. Click OK. Your computer will restart. 
Proceed to Configuring the Business Internet High Speed software on the next page.

I N S T A L L I N G  T H E  B U S I N E S S  I N T E R N E T  H I G H  S P E E D  S O F T W A R E



10   Configuring the Software

Note: the Business Internet High Speed software is not designed to support Internet access 
over a Local Area Network (LAN). Configuring the Business Internet High Speed software 
may cause conflicts with your existing network service.

1. Click the Apple  menu in the top-left corner of the screen.

2. Click Control Panels, then click TCP/IP from the sub-menu. If you see a message saying that TCP/IP is 
not active, activate it by clicking Yes.

3. Click the menu next to Connect Via and select 
Internet High Speed Classic.

4. Click the menu next to Configure then select 
Using PPP Server.

5. Click in the Name server addr box, and type 
2.3.4.5, then press Return, then type 6.7.8.9.

6. Click the File menu, then select Quit.

7. Click Save to save your settings.

8. Open the Internet High Speed folder, then double-click the Business Internet High Speed icon in the 
Internet High Speed folder.

9. The Business Internet High Speed software starts. 
Click the pull-down menu next to Connect via and 
click Ethernet.

10. Type your Business Internet High Speed User ID and 
your Business Internet High Speed password in the 
User ID and Password boxes respectively. Make sure 
that your User ID is followed by the @ symbol and 
your domain name.

11. Close the Business Internet High Speed window and 
click Save to save your settings.
For information on connecting automatically with 
the Business Internet High Speed software, please 
refer to Connecting automatically to the Business 
Internet High Speed Service on page 12.

C O N F I G U R I N G  T H E  B U S I N E S S  I N T E R N E T  H I G H  S P E E D  S O F T W A R E

3
4

5

9
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You have configured your computer’s TCP/IP settings. Please proceed to Configuring the 
Internet Explorer Software below.

1. Double-click the Internet High Speed folder on your hard drive.
2. Double-click the Business Internet High Speed icon in the Internet High Speed folder.
3. In the Business Internet High Speed window, click the Connect button.
4. Double-click the Applications folder (or whatever folder you chose to install the software into).
5. Double-click the Microsoft Internet 5 folder.

6. Double-click the Outlook Express  icon.

7. In Outlook Express, click the Tools menu, then click Accounts.
8. In the Accounts window, click the New button.
9. Follow the instructions provided by the Account Setup Assistant. You will need the following information 

to configure your Business Internet Dial settings.
• Your desired email display name
• Your email address
• Incoming mail POP3 Server: pop51.bellnet.ca
• Outgoing mail SMTP Server: smtp10.bellnet.ca
• Your user/account name
• Your password

10. Click the News tab, then click Add.
11. Follow the instructions provided by the Account Setup Assistant. You will need the following information 

to configure your Business Internet Dial settings.
• Your desired display name
• Your email address
• News Server: news21.bellnet.ca

12. If you wish to import mail and preferences from other mail programs, click the File menu in Outlook 
Express, then click Import, then follow the instructions.

The installation and configuration of your Business Internet High Speed software is now 
complete. For information on how to use the Business Internet High Speed software refer to 
Connecting and Disconnecting from the Internet on page 12.

C O N F I G U R I N G  T H E  I N T E R N E T  E X P L O R E R  S O F T W A R E



12   Connecting and Disconnecting from the Internet

7

You must install the Business Internet High Speed software to connect and disconnect from the 
Business Internet High Speed service. To install the Business Internet High Speed software, 
follow the instructions in Configuring the Software on page 8.

If you have Mac OS X, please turn to Connecting to the Business Internet High Speed with Mac OS X on 
page 13.

1. Double-click the Business Internet High Speed icon in the Internet High Speed folder. The Business 
Internet High Speed software starts.

2. Click Connect to connect to the Business Internet High Speed service.

1. In Internet Explorer, click the File menu, then click Quit.

2. To disconnect from the Internet, double-click the Business Internet High Speed icon in the Internet 
High Speed folder, then click Disconnect.

This is helpful from a security perspective if you happen to forget you are connected or do not want 
anyone else to use your account.

a. Double-click the Business Internet High Speed icon in the Internet High Speed folder.
b. Click Edit, then click Preferences.
c. In the Preferences window, select a number of minutes in the pull-down menu next to Idle Timeout 

Value. Click Save. The next time you connect, you will be automatically disconnected if you are not 
using the Internet after the number of minutes you specified. When you want to re-connect, click 
Connect in the Business Internet High Speed window.

If you want to connect automatically (that is, you don’t want to manually start the Business Internet High 
Speed software and click the Connect button each time), follow these instructions.

1. Double-click the Business Internet High Speed icon in the Internet High Speed folder.

2. Click Edit, then click Preferences.

C O N N E C T I N G  A N D  D I S C O N N E C T I N G  F R O M  T H E  I N T E R N E T

C O N N E C T I N G  T O  T H E  I N T E R N E T

D I S C O N N E C T I N G  F R O M  T H E  I N T E R N E T

CONFIGURING THE BUSINESS INTERNET HIGH SPEED SOFTWARE TO DISCONNECT AFTER A SET AMOUNT OF TIME

CONNECTING AUTOMATICALLY TO THE BUSINESS INTERNET HIGH SPEED SERVICE
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1. Click the Apple  menu, then click System Preferences.

2. In the System Preferences window, click Network.

3. In the Show menu, click Active Network Ports. Uncheck the ports you do not need. Normally you 
should only have Built-in Ethernet checked.

4. Click the Show menu again, then click Built-in Ethernet.

5. Click the PPPoE tab. Check the Connect using PPPoE box.

6. Type your Business Internet High 
Speed username (followed by @ 
and your domain name) and 
password in the appropriate 
boxes. In the Service Provider 
box, type Business Internet High 
Speed. Leave the PPPoE Service 
Name box blank.

7. Check the Save password box if 
you do not want to type your 
password in every time you 
connect.

Note: checking this box will allow 
all users of this computer to 
connect without typing a 
password.

8. Check the Show PPPoE status in 
menu bar box.

9. Click the PPPoE Options button.

3. In the Preferences window, check Automatically connect on launch if you want to connect automati-
cally, bypassing the need to click the Connect button.

4. Uncheck Launch Browser after Connection if you do not want the Web browser software to start 
automatically after the Business Internet High Speed software connects.

5. If you want the browser to start automatically, check this option and type the URL you want the browser 
to start with in the box.

6. Click Save.

7. Click once on the Business Internet High Speed icon. Click the File menu, then click Make Alias.

8. Drag the alias of the Business Internet High Speed icon into the Startup Items folder in the System 
Folder. The next time you start your computer, the Business Internet High Speed software will start 
automatically.

C O N N E C T I N G  T O  T H E  B U S I N E S S  I N T E R N E T  H I G H  S P E E D  W I T H  M A C  O S  X

6

7
9
8
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10. If you check Connect automati-
cally when starting TCP/IP appli-
cations, then you will 
automatically be connected to the 
Business Internet High Speed 
service when you start your 
browser or email program.

11. If you check Disconnect when 
user logs out, you will be discon-
nected when you log out of OS X. 
We recommend that you check 
this option.

12. Click OK to close the Options 
window.

13. Click the Save button at the 
bottom of the System Preferences 
window, then quit System Preferences.

14. To connect to the Business Internet High Speed service, click the Ethernet icon  in the menu bar, 
then click Connect.

15. To disconnect from the Business Internet High Speed service, click the Ethernet icon  in the menu 
bar, then click Disconnect.

1. In Outlook Express, click File, then Import. The Outlook Express Import window appears.

2. Follow the instructions to import your mail from another program.

If a second person is using Outlook Express and you wish to keep your mail separate, follow the instruc-
tions below.

1. In Outlook Express, click File, then Switch Identities.

2. Click Switch.

3. In the window that appears, click New.

4. Type a name for the identity, then click OK.

5. The mail account information is imported into your new identity by default.

11

10

I M P O R T I N G  M A I L  F R O M  A N O T H E R  E M A I L  P R O G R A M

C R E A T I N G  A  S E C O N D  O U T L O O K  E X P R E S S  I D E N T I T Y
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As a subscriber of the Business Internet High Speed service, support for the Business Internet High Speed 
software is always available. Business Internet High Speed Services do not provide support for software other 
than the Internet Explorer software and the Business Internet High Speed software that are included with the 
Business Internet High Speed service. Most problems are easy to solve. Here are the solutions to some of the 
most common problems you might encounter.

PROBLEM SUGGESTED ACTION REFERENCE

The power light on my 
Efficient Networks 
SpeedStream 5200 
modem is blinking red

The power light will blink red for a few minutes after the 
power supply is connected.

Checking your 
setup on 
page 6

I want to set up another 
Outlook Express Identity 
with my Business Inter-
net High Speed settings

Follow the instructions under Creating a second Outlook 
Express Identity on page 14

Creating a sec-
ond Outlook 
Express Identity 
on page 14

You don’t have enough 
free hard drive space to 
install the Business 
Internet High Speed 
software

Delete any files you don’t need, but do not delete files if you 
don’t know what they are for. Empty the Recycle Bin or 
Trash. Try to install the Business Internet High Speed soft-
ware again.

Configuring the 
Software on 
page 8

Your computer crashed 
while using the browser 
(computer will not 
respond to mouse)

Low disk space: Make sure that you have sufficient free disk 
space on your computer. Empty the Recycle Bin or Trash. 
You may need to delete some files from your hard drive.
Corrupt cache: To clear the cache with Internet Explorer, 
click the Edit menu, click Preferences, click Advanced, then 
click Empty Now. Click OK.

“System Error”, “Appli-
cation Error”, or “Gen-
eral Protection Fault”

These are operating system errors. Please refer to the user 
manual that came with your computer.

You cannot browse the 
Internet

Make sure that the cable is connected securely to the Effi-
cient Networks SpeedStream 5200 modem and cable, and 
that you are using the right kind of cable.
If you are using the Ethernet cable, turn the Efficient Net-
works SpeedStream 5200 modem off, then back on.

Installing the 
Hardware on 
page 3

T R O U B L E S H O O T I N G
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PROBLEM SUGGESTED ACTION REFERENCE

You see a message 
about a network error

Exit the browser software, then restart your computer and 
try connecting again.
Follow the instructions under Your computer crashed while 
using the browser (computer will not respond to mouse) on 
page 15.Turn Virtual Memory off (if it was on). To do this, 
click the Apple  menu, click Control Panels, then click 
Memory. Switch Virtual Memory off, close the Memory 
window, restart your Macintosh, and then start your 
browser.

You see an error mes-
sage of type #1, #10 or 
#11 when starting the 
browser

1. Click on the Apple  menu, click Control Panels, then 
click Extensions Manager.

2. Click on the menu beside the Selected Set: option and 
select Mac OS 8.X All or Mac OS 9, then also make sure 
that the item Business Internet High Speed is checked. 
Click Restart at the bottom of the window.

3. Make sure that virtual memory is off. To do this, click the 
Apple  menu, click Control Panels, then click 
Memory. Switch Virtual Memory off, close the 
Memory window, restart your Macintosh, and then 
start your browser.

You see a message 
about Business Internet 
High Speed not being 
configured to automati-
cally make a connection

Start the Business Internet High Speed software and click 
Connect before you start your browser or email software.

The Business Internet 
High Speed software 
stops at “Negotiating 
link” when you try to 
connect

1. Ensure that the DSL high speed modem is connected to 
the Ethernet card.

2. Ensure that the DSL high speed modem is on.

The Business Internet 
High Speed software 
stops at “Authenticat-
ing” when you try to 
connect

1. Make sure you have typed your Business Internet User 
ID correctly and in lower case letters in the User ID box.

2. Make sure you have typed your Business Internet 
password correctly in the Password box.

3. Make sure that your network name is entered in lower-
case letters in the Network box.

The Connect via: Inter-
net High Speed Classic 
option does not appear 
in the TCP/IP control 
panel

Reinstall the Business Internet High Speed software as 
described in Configuring the Software on page 8.

Configuring the 
Software on 
page 8
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REMOVING THE BUSINESS INTERNET HIGH SPEED SOFTWARE FROM THE COMPUTER

Removing the Business Internet High Speed software:
a. Drag the Business Internet High Speed folder to the Trash.
b. Double-click your System Folder, and double-click the Extensions folder. Drag Internet High

Speed Classic from the Extensions folder to the Trash.
c. Double-click the Control Strip Modules folder in the System Folder. Drag Internet High Speed

Strip to the Trash.

•

• As part of your Business Internet High Speed membership, the Help section of the Business Internet 
High Speed Web site (http://en.bellnet.ca) is a great resource for up-to-date information about your 
account and how to use the Business Internet High Speed software. At any time you are connected to 
the Internet, click the Help button on any Business Internet High Speed page. You will be linked to the 
latest news and tips about your Business Internet High Speed software, including information about 
available upgrades, and billing information.

• If you need help using the Internet Explorer software, you can consult its built-in help by clicking the 
Help menu, then by clicking Internet Explorer Help.

• You can get help for the Business Internet High Speed software by double-clicking the Business Internet 
High Speed icon, double-clicking the Business Internet High Speed icon, then clicking the Help button. 
You do not have to be online to do this.

• If you receive an error message on your screen, please write it down before contacting our support ser-
vices. Also, if the error occurred while following the instructions in this guide, note the page and step 
you were at. This information will help the technical support agent’s give you the assistance you need 
as quickly as possible.

• If you cannot send email to our support services, please have your personal Business Internet account 
information in front of you, then call the Business Internet Technical Support Line. The appropriate 
number for your region is on the first page of this guide.

PROBLEM SUGGESTED ACTION REFERENCE

The Connect Via: 
Ethernet built-in does 
not appear in the Busi-
ness Internet High 
Speed software

Click the Apple  menu, click Control Panels, then click 
Extensions Manager. In the Extensions Manager list, make 
sure the Ethernet (Built-in) extension is checked. If your 
Ethernet card is not an Apple Ethernet card, select the 
proper extensions for your card. If the extensions are not 
present in the Extensions Manager window, reinstall the 
driver for your Ethernet card from the original disks or from 
your Apple System CD-ROM.

The TCP/IP control 
panel isn’t installed or 
doesn’t appear in the 
Control Panels menu or 
folder

Reinstall Open Transport from the Mac OS CD that came 
with your computer. Consult the instructions that came with 
your Mac OS CD for more information.

O T H E R  T R O U B L E S H O O T I N G  R E S O U R C E S
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As part of your Business Internet High Speed service your receive 20 hours of Business Internet 
Dial service FREE each month! When you want to access the Business Internet service while 
away from the office, you can use a dialup connection. Follow the directions below to 
configure a dialup connection.

You will need the following items.

• A regular dial-up modem to connect your computer to a telephone line.
• Your Business Internet Login ID and password.

Ensure that your regular dial-up modem is installed. If necessary, consult the documentation that 
came with your modem.

1. Insert the Business Internet Dial CD into your CD-ROM drive.
2. Double-click the Dial folder, then the BELL_NEXXIA_MAC_iPC_v18 icon in the CD-ROM window.
3. Follow the instructions to install iPassConnect.
4. After iPassConnect is installed, double-click your hard drive icon, then double-click the iPassConnect 

folder.

5. Double-click the iPassConnect icon. 

6. The first time you start iPassConnect, the End User Agreement appears. Read the agreement, and click 
Agree if you agree.

7. In the iPassConnect- window, click your country 
in the Country pull-down menu.

8. Click you Province in the State pull-down 
menu.

9. Click your city in the City pull-down menu.
10. Click the number you want to dial from the list 

that appears in the Phone Book section of the 
window.

11. If you need to use dialing prefixes or codes to 
turn off Call Waiting™ or to access an outside 
line before dialing, click Dial Properties and 
type them in the Dial Properties window.

SECTION 2: SETTING UP YOUR OPTIONAL BUSINESS INTERNET DIAL HOURS

C O N F I G U R I N G  A  D I A L - U P  C O N N E C T I O N  W I T H  M A C  O S  8 . 6  A N D  9
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12. Click Connect to connect to the Business Internet 
Dial service. A User Info window will appear. Type 
your Business Internet Dial username and 
password in the boxes provided. If your domain is 
not bellnet.ca, ask your account administrator for 
your domain, and type it in the Domain box. Click 
Connect.

13. If you need more help using the iPassConnect 
software, click the Help menu, then click iPass-
Connect Help.

14. Double-click the Internet Explorer icon in the 
Microsoft Internet 5 folder.

1. Quit the Internet applications you are using.
2. Click iPassConnect in the Application menu (in the top right hand corner of the screen).
3. From the iPassConnect File menu, click Disconnect.

If you have created a dialup connection on a computer that was used for your Business Internet High 
Speed account, and you now want to use your Business Internet High Speed account again, simply 
follow the instructions under Configuring the Business Internet High Speed software on page 10 to connect 
with the Business Internet High Speed software.

D I S C O N N E C T I N G  F R O M  T H E  I N T E R N E T

C O N N E C T I N G  T O  Y O U R  B U S I N E S S  I N T E R N E T  H I G H  S P E E D  S E R V I C E
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1. Click the Apple menu, then click System Preferences.
2. In the System Preferences window, click Network.
3. In the Location menu, click New Location.
4. Type Dialup as the name of your new location, then click OK.
5. In the Show menu, click Active Network Ports. Uncheck the ports you do not need. Normally you 

should only have Modem checked.
6. Click the Show menu, then click Modem.
7. Click the TCP/IP tab. Click the 

Configure menu, then click Using 
PPP.

8. Click Save or Apply Now at the 
bottom of the window. Then click 
the PPP tab.

C O N F I G U R I N G  A  D I A L - U P  C O N N E C T I O N  W I T H  M A C  O S  X
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9. Type your Business Internet 
username (followed by @ and your 
domain name) and password in the 
appropriate boxes. Type your local 
dial-up access number in the 
Telephone number box. In the 
Service Provider box, type 
Business Internet Dial.
Refer to Dial-up Numbers on 
page 29 for a list of dial-up 
numbers.

10. Check the Save password box if 
you do not want to type your 
password in every time you 
connect. Note: checking this box 
will allow all users of this computer 
to connect without typing a 
password.

11. Click the PPP Options button.
12. If you check Connect automatically 

when needed, then you will automati-
cally be connected to the Business 
Internet service when you start your 
browser or email program.

13. Make sure that Disconnect when user 
logs out is checked.

14. Click OK to close the Options window, 
then click the Save or Apply Now button 
at the bottom of the System Preferences 
window. Then click the Modem tab.



22  Section 2: Setting up your optional Business Internet Dial Hours

15. Make sure that your modem is 
selected in the Modem menu.

16. Make sure that Show modem 
status in menu bar is checked.

17. Click Save or Apply Now, then 
quit System Preferences.

To connect to the Business Internet Dial service, click the Modem icon  in the menu bar, then click 
Connect.

To disconnect from the Business Internet Dial service, click the Modem icon  in the menu bar, then 
click Disconnect.

C O N N E C T I N G  T O  T H E  I N T E R N E T  W I T H  M A C  O S  X

D I S C O N N E C T I N G  T O  T H E  I N T E R N E T  W I T H  M A C  O S  X
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7

As a subscriber of the Business Internet Dial service, support is always available to you. Most problems are 
easy to solve. Here are the solutions to some of the most common problems you might encounter while 
installing and using the software.

PROBLEM SUGGESTED ACTION REFERENCE

There is no dial tone 
present on your phone 
line

If your connection software tells you that your phone line 
does not have a dial tone, here are some tips to help you 
resolve the problem:
• Pick up the receiver of your telephone and listen for a 

dial tone. If you do not hear a dial tone, another tele-
phone on the same line might be off the hook. Or, there 
might be something wrong with your phone line.

• Make sure that the modem is turned on, and that the 
phone cables are properly connected to the modem 
and the phone line. Most modems have two ports on 
the back. One should be connected to your telephone 
wall jack, and the other may be connected to a standard 
telephone. Dial tone errors may result if the two lines 
are reversed. External modems will also have a cable 
which connects the modem to the back of your com-
puter, and a power cord which reaches from the 
modem to the electrical wall outlet. Make sure all cables 
and the power cord are firmly plugged in. If the modem 
has external lights, at least one of them should be on.

• If you have Call Answer or Message Manager service on 
the phone line used by your modem, and you have new 
messages waiting, most modems require that you listen 
to your messages before trying to connect. Often these 
extra phone services provide warnings and notifications 
to the customer by sending a slightly different dial tone, 
which may not be properly detected by your modem.

T R O U B L E S H O O T I N G
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PROBLEM SUGGESTED ACTION REFERENCE

You can’t connect to the 
Business Internet Dial 
service

• Check for a dial tone on your phone line. For more 
information, please consult There is no dial tone present 
on your phone line above.

• Your modem may need to be reset for it to initialize 
properly. If you have an external modem, you can reset 
it simply by turning it off and then on again. If you have 
an internal modem, you will need to shut down your 
computer and restart it again. Once your modem has 
been reset, try connecting again.

• Verify that any required software for your modem has 
been installed properly. If you are not sure about 
whether your modem includes special software, look in 
the user guide that came with your modem. If you are 
not sure whether the software is present on your com-
puter, reinstall the software according to the manufac-
turer’s instructions.

• Make sure that no other programs are currently using 
your modem, such as fax software waiting for an 
incoming fax.

The browser is unable to 
connect to the network

Clear the browser’s cache:
• To clear the cache with Internet Explorer, click the Edit 

menu, click Preferences, click Advanced, then click Empty 
Now. Click OK.

• Try reloading the page using the Reload or Refresh but-
ton on the browser toolbar.

• If this does not work after a couple of tries, quit the 
browser, disconnect from the Business Internet Dial ser-
vice, and check that your name server addresses in the 
TCP/IP Control Panel are correct.

• Turn Virtual Memory off (if it was on). To do this, click 
the Apple menu, click Control Panels, then click Mem-
ory. Click Off under Virtual Memory, close the Mem-
ory window, restart your Macintosh, and then start 
your browser.

Note: These are generic errors. Do not assume that the Busi-
ness Internet Dial service is unavailable.

The Connect button is 
greyed out in PPP or 
Remote Access

To solve this problem, click the Apple  menu, select Con-
trol Panels, and then click TCP/IP. Make sure the Connect 
Via option is set to PPP.
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REMOVING THE GLOBAL ROAMING SOFTWARE

1. Drag the iPassConnect folder to the Trash.

IF NONE OF THE RESOURCES ABOVE HAVE ANSWERED YOUR QUESTION OR PROBLEM

Don’t worry, we’re here to help you. Our support services are staffed by friendly experts who will be happy 
to answer your questions.

If you receive an error message on your screen, please write it down before contacting our support 
services. Also, if the error occurred while following the instructions in this guide, note the page and step 
you were at. This information will help our support services give you the assistance you need as quickly 
as possible.
If you cannot send e-mail to Member Services, please have your personal Business Internet Dial account 
information in front of you, then call the Business Internet Technical Support Line. The number is on 
the first page of this guide.
Please remember that our support services are only equipped to answer questions related to the 
Business Internet Dial software described in this guide.

PROBLEM SUGGESTED ACTION REFERENCE

You see a message say-
ing there is a problem 
with the modem

This problem occurs if your modem requires the use of a 
high-speed modem cable and you are not using one. Try to 
use the cable that came with your modem. If it is not avail-
able, obtain a modem cable that is specifically designated 
“high speed”. It has wires for signals that regulate the flow 
of data at high speed.

Your new modem does 
not seem to be working

When you change modems you need to update your 
modem settings to be able to connect to the Business Inter-
net Dial service. Once you have physically installed the new 
modem and any driver software that came with it, follow 
these instructions:
1. Exit your browser software.

2. Click the Apple  menu, select Control Panels, then 
select Modem. Check to see that your modem settings 
are correct. Check the documentation that came with 
your modem.

The TCP/IP control 
panel isn’t installed or 
doesn’t appear in the 
Control Panels menu or 
folder

Reinstall Open Transport from the Mac OS CD that came 
with your computer. Consult the instructions that came with 
your Mac OS CD for more information.

Removing the Business 
Internet Dial software 
from your computer

Locate the Microsoft Internet folder by double-clicking on 
the icon for your hard drive. Drag the Microsoft Internet 
folder to the trash.

O T H E R  T R O U B L E S H O O T I N G  R E S O U R C E S
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There are two methods by which you can access your email accounts. The first method is by
setting up an email account in Outlook Express. This is automatically set up for you once you
complete Configuring the Internet Explorer Software on page 11.

The second method is through the world wide web from any computer! For more information,
please see Unified Web Messaging below.

Unified Web Messaging, offered to Bell Business Internet customers free of charge, provides you with a single 
convenient Web interface to access and manage all of your Web-based messaging services.

H O W  D O  I  A C C E S S  M Y  E M A I L  A C C O U N T  O N L I N E ?

Web access to email (also known as Webmail) is a free service that lets you access your email account over 
the Internet, giving you total mobility and freedom to travel. You get access to most of the same features as 
your regular email. Additional services include anti-spam, vacation alerts, forwarding, etc.

• From http://en.bellnet.ca, click the e-mail located on the toolbar on the left-hand side of the screen, 
then click the Unified Web Messaging link. You will then be prompted for your Business Internet e-
mail address and Password. You should use the Business Internet email address and password provided 
in your starter kit.

• Once you have accessed your email online you have entered the Unified Web Messaging Interface, at 
this time you will have the option to use all of the other features listed below.

• Complete your profile settings if you do not want to enter your user ID and password for each of the 
applications you use on Unified Web Messaging, you will only need to enter them once in the Profile 
section.

W I R E L E S S  A C C E S S  T O  E M A I L

Wireless access to email lets you configure your business email account so you will be able to access your 
messages on your Bell Mobility PCS phone (via the mobile browser service). You can view your email 
messages by scrolling down on the display screen. Wireless access to email is free.

W I R E L E S S  A C C E S S  T O  V O I C E N E T  S E R V I C E S

Wireless access to VoiceNet services allows you to keep up-to-date and stay connected to the world through 
your cellular phone. You can listen to helpful audio information, such as stock quotes, sports updates and 
weather forecasts, or even hear your email messages. Voice-activated navigation provides safe, convenient 
and hands-free access. VoiceNet services are subscription-based.

T E X T  M E S S A G I N G  ( S M S )

The text messaging (SMS) lets you send messages to Bell Mobility subscribers from anywhere in the world. 
There is no charge for the person sending the message, but there is a charge for the person receiving it.

E M A I L

U N I F I E D  W E B  M E S S A G I N G
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E P A G E  M E S S A G I N G

EPage messaging allows you to easily connect your Bell Mobility pager to the Internet. You can forward 
office and Internet email directly to your pager and receive messages from any Internet site in the world via 
webDirectTM, Bell Mobility’s World Wide Web paging interface (the first 100 characters are sent to alphanu-
meric pagers only). To access this service, you must use Internet Explorer.

S U P P O R T

For the support of specific services within Unified Web Messaging, please click the Help buttons available in 
each application.

The following features will provide you with greater security and more flexibility when managing your email 
accounts. Here is an overview of our features, for more information you can visit our Website at 
www.bell.ca/bizemailinfo.

A N T I V I R U S

Scan and clean all incoming emails for viruses before they reach your computer.

I M A P 4

Store and manage mail on the server as well as create folders to organize messages.

S S L  E N C R Y P T I O N

Allows you to send and receive email through a Secure Socket Layer (SSL). This is the industry standard for 
security.

A D D I T I O N A L  S T O R A G E

Allows you to increase your mailbox storage on individual email accounts in increments of 10MB, providing 
more flexibility and helping you manage your emails.

E M A I L  D E L U X E  B U N D L E

The bundle includes antivirus, IMAP4, SSL Encryption, and 10MB of additional storage.

S E C U R E  L O G O N  T O  W E B M A I L

This feature will encrypt the logon activities of users when they access the Web interface. It ensures that your 
user ID and password are protected (through encryption) when logging on through the Webmail site.

Z I X M A I L

This end to end email encryption solution allows you to send secure email to any email addresses. This 
service prevents security breaches and protects confidential information from falling into the wrong hands.

S E C U R I T Y  A N D  M A N A G E M E N T  E M A I L  F E A T U R E S
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SUBSCRIBE TODAY BY VISITING OUR BELL WEBSITE AT http://en.bellnet.ca AND CLICK eCARE!

W H E R E  T O  F I N D  T H E  E C A R E  T O O L

1. Go to the Bell website. (http://en.bellnet.ca).
2. Click eCare.
3. Click Enter on the Online Services home page.

To ensure that only authorized personnel have access to eCare, it will ask you the following information:

• User name (Login ID) - Code d’utlitisateur The same as your Business Internet Access account login 
ID. For example, yourID@bellnet.ca (if you have a standard domain name) or yourID@yourcom-
pany.com (if you have a custom domain name).

• Password: The same as your Business Internet password.

If you have any question about eCare, please call our Business Office. For the Business Office number please 
refer to Contact Numbers on the first page of this guide.

eCare is an online account management tool for your Bell Business Internet account. Since it is available on 
World Wide Web, it’s accessible from anywhere at any time and puts you in direct control of your account. It 
can help you to:

• Create more Dial up users within minutes
• Order additional High Speed service
• Create email accounts
• Suspend users
• Check the usage details
• View invoices
• Change passwords, etc.
• Subscribe to email features (NEW!)

Individual users will have access to only their own account information. However, company designated IT 
Administrators will have access to all features. If during the initial setup, you did not register yourself as an IT 
administrator, call our Business Office. For the Business Office number please refer to Contact Numbers on 
the first page of this guide.

E C A R E

S E T T I N G  U P  A D D I T I O N A L  E M A I L  A C C O U N T S  W I T H  E C A R E
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D I A L - U P  N U M B E R S

Abbotsford 604-755-7003
Barrie 705-721-5572 Northbay 705-474-1047
Belleville 613-966-8374 Oshawa 905-571-6869
Brantford 519-750-0010 Ottawa 613-350-2243
Brockville 613-345-3236 Owen Sound 519-371-7542
Calgary 403-237-7314 Pembroke 613-735-8124
Chatham 519-352-6634 Prince George 250-275-7007
Chicoutimi 418-696-0028 Peterborough 705-745-5737
Clinton 519-482-8542 Quebec City 418-694-1429
Cobourg 905-377-1400 Red Deer 403-755-7999
Cornwall 613-932-2576 Regina 306-545-5678
Drummondville 819-472-7461 Riviere Du Loup 418-860-2701
Edmonton 780-990-0016 Roberval 418-275-1698
Elliot Lake 705-461-8139 Sarnia 519-332-6501
Fort MacMurray 780-747-7999 Sault Ste. Marie 705-254-1974
Granby 450-777-1412 Sherbrooke 819-829-5847
Grand Prairie 780-833-7999 Sorel 450-742-9463
Guelph 519-767-0495 St. Catherines 905-684-3106
Haliburton 705-457-2180 St. Hyacinthe 450-773-8377
Halifax 902-454-0933 St. Jerome 450-432-6734
Hamilton 905-546-9642 St. John’s 709-739-6618
Huntsville 705-788-3210 St. Jovite 819-425-3470
Joliette 450-759-0596 St-Agathe 819-321-2396
Kelowna 250-448-7042 Sudbury 705-669-1712
Kamloops 250-434-7000 Thetford Mines 418-335-7772
Kingston 613-536-1639 Thunder Bay 807-623-1307
Kitchener 519-743-3791 Toronto 416-681-1168
La Malbaie 418-665-8032 Trois Rivi res 819-694-7562
Lindsay 705-324-1153 Valleyfield 450-373-2231
London 519-438-9242 Vancouver 604-602-3087
Medicine Hat 403-488-7999 Vernon 250-275-7007
Moncton 506-382-4564 Victoria 250-220-7005
Montreal 514-350-5262 Victoriaville 819-752-6347
Newmarket 905-954-0660 Windsor 519-561-7330

Winnipeg 204-957-7441
North America Wide
Number*

1-800-670-7489
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* The North America wide number is useful for those areas where there is no local PoP 

• The list provides the names of the cities where this service is available locally.
• Calls to a neighbouring town may be local to a PoP city. For example, calls from Mississauga (905 area 

code) are local to our PoP in Toronto (416 area code)

Checking specific customer locations

English: http://en.bellnet.ca/poptool/dialpops.jsp


